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Introduction/History
Rinex Manager (RM) came about during the active phase of our static GPS campaigns within Gila County, Arizona. File processing is much easier if the RINEX Header is complete and accurate. The tools freely available for header editing at the time were NGS’ PAGE-NT software and TEQC from UNAVCO. The alternative was a text editor software making changes by hand.
The NGS software was not conducive to software automation; where TEQC had a dos version that was command line driven and ideal for automation. The only problem was that there was no Windows version. This was the rationale behind RM as a Windows Interface for TEQC’s header editing functions.

In 2008 the Arizona NGS State Advisor asked that RM be extended to include functionality for creation of the NGS B-File. It was quickly realized that a complete RINEX Header and NGS spec file name along with the project SERFIL file would provide the majority of information required to create a valid B-File. The balance of the missing information related to Project details could be entered in one of 2 windows.
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Installation

Installation of RM is straight forward. The package has a setup.exe and RMSetup.msi. Double click to start the install process and follow the prompts. By default, the software installs to C:\Program Files\GPS Tools\Rinex Manager. 

TEQC is also installed to the same install directory as the application and is central to the operation of RM. At the time of this writing, the TEQC version was 2009Oct09. As newer versions of TEQC are released the TEQC.exe can be replaced with the more current executables. The TEQC.exe should be renamed prior to copying the new version in case changes to TEQC cause the software to behave oddly.
This software is not equipped with an uninstall operation.  Please remove older versions of this software prior to installation.

Operation

The operation of RM is fairly linear in scope.  Once the software is started, the main interface comes up:
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The File menu item has no function at this time; it is a placeholder for future development.
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The Tools menu allows access to a Configuration screen where options can be altered.
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The Help menu has the usual information
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The white square represents the pending Rinex files awaiting addition to the queue. 
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The grey tab area represents the working command area.

Getting Started

To get started, it is best to go into the Configuration screen to set your desired defaults. Click 'Tools>Configuration'
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The Misc Items Tab has the following options:

· Show Disclaimer on Startup

By checking this box, the disclaimer screen will be shown at startup.
By un-checking this box, the disclaimer screen will be hidden at startup.

· West Longitude

This option allows the user to set their preferred Longitude units during display. 
By checking this box, the West Longitude values will be defaulted to a positive value.

By un-checking this box, the West Longitudes will be defaulted to a negative value. 

· File List Right Scroll 
This option affects the contents of the File list on the main screen. 
By checking this box, the list will be right justified. This becomes relevant if you have a complex directory structure and you cannot see the actual file name.
By un-checking the box, the list will be left justified.

· Units 
· DMS 
By checking this circle, the unit default will be set to Degrees Minutes Seconds.

· D.dddd

By checking this circle, the unit default will be set to Decimal Degrees.

· Decimal Units (1-5)

This allows the option of the number of decimal places entered after the decimal with five (5) being the maximum and one (1) being the minimum.
· Form Opacity (25% - 100%)
This option was added for convenience when working with a single monitor working environment.  It allows the user to interface with other programs for data entry tasks.
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The NGS Support Tab has the following options:

· NGS FTP Location:

This sets the default location of the ant_info.003 file off of the NGS website for updating.
· Ant_info.003 local directory:

This sets the default location for the ant_info.003 file locally.
· BFile *13* record Format
· NGS Spec – SemiMajor Axis and flattening

By checking the circle, the Semi-Major Axis of 6378137000 is place in cc 51-60 of the *13* record and the Inverse Flattening of 2982572221 is placed in cc 61-70 of the *13* record.
· Alt Spec – SemiMajor and SemiMinor Axies

By checking the circle, the Semi-Major Axis of 6378137000 is placed in cc 51-60 of the *13* record and the Semi-Minor Axis of 6356752314 is placed in cc 71-80 of the *13* record.
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The OPUS Tab has the following options:
· OPUS Website

The user can set the default HTTP://... url location for the OPUS website.
It is currently located at:   http://www.ngs.noaa.gov/OPUS/

· Email Address:

The user can set their default email address.
After the configuration options have been set, it will hold for future sessions.

Getting to Work
A quick note about random mouse movement, when the mouse enters the list of Rinex files, all values are reread so be careful about where the mouse pointer is.
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To get going, click on the Get Files button to bring up a standard Windows folder dialog and navigate to the folder where your Rinex files are kept.  
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Once OK is pressed the file list will be populated with the contents of the chosen folder. 
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Note: For the files to show up in the file list, their extension must either end in an ‘o’ as in AZGB1370.09o (current NGS 8.3 file naming specification) or ‘obs’ (an older Rinex specification) as in AZGB1370.obs. Other file extensions are not supported at this time.
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Once these files have been loaded, additional tabs will become available for use. Also, the various reference values will be populated for the selected Rinex file.
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· Start/Stop times: 
These values are based on GPS time. These values have not been corrected for leap seconds or Time Zone Variations.

· Duration:

This value is the length of the selected file active observation time. It is assumed that there exists 1 observation in a given Rinex file.

· Interval:

This value is the frequency of the GPS observations.
· Position:

This value is the Latitude, Longitude and Ellipsoid Height and is calculated from the selected Rinex file’s position information.
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The Checkboxes along the bottom have the following functionality:

· Debug Output  
By checking this box, it enables the Debug Tab.

By un-checking this box, it disables the Debug Tab.

During testing it was handy to have a debug window available.
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· Opaque Form 

By checking this box, it makes the Rinex Manager Opaque.

By un-checking this box, it makes the Rinex Manager Non-Opaque.

The instructions for the settings for this option are contained on Page 7 of this manual.
· Messagebox Control 

Also, during testing it was good to see interaction with TEQC. With this control checked the results of various commands are brought up.
File Management Tab
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Once a list of Rinex files has been selected, additional items become available on this tab for general file housekeeping.  The software was written to except only Rinex files with the NGS suggested format of xxxxyyyz.nno.
xxxx = 4 character siteID as defined in the SERFIL file

yyy = Day of year of the observation

z = session id for this file  (**NOTE – z is placed in cc 20 of the *25* record.  Visually, it is easier to have this be a letter a, b, c, etc. due to the numerous numbers contained in these records**)
nn = Ending 2 digits of the year of observation (i.e. 08 for 2008)

· 4 Char Rename
This allows the renaming of the first 4 characters (xxxx) to the siteID value.
· Session Rename
This allows the setting of the session id (z) (**As noted above, this value should be a letter a, b, c, etc. for visual ease.**)
When a rename function occurs, the corresponding *.??n or *.nav  navigation file is attempted to be renamed as well. The G and M files are be ignored.

The Header Editor Tab
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The Header Editor Tab is where changes to the Rinex header are updated to reflect appropriate data and is a required element of the NGS B-File.
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When a change is made to any of these fields the label background will change to Yellow (Antenna Type is a special case discussed below) and the check box next to it will be set. This is to identify that a change has been made to the respective field. Adding a character and then deleting that character is still considered a change even though there is no net effect on the data.
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To save the changes, the Update Item(s)? check box must be checked. This will enable the Set Values button to be clicked. Only the fields that were checked will be updated so you can withhold each field independently. Once the changes have been applied, you can either click on the Get Values button or move the mouse back into the list of files area. This will refresh the fields.
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Frequently, multiple files must be edited with the same data due to multiple sessions. That is the function of the Use Last Values button. Once the first file has been edited and changes saved, select the next file in the session and reuse the material you just changed with this button. This works with everything except the ECEF position as a safety. ECEF must be edited separately, though in the same fashion.
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The Antenna Type is a special case like previously mentioned. When editing this value, the contents of the field are checked against the Ant_info.003 file maintained by NGS. If the value for the antenna type is not found in the NGS file, the background will change to a reddish color indicating a problem. If you do not know the specific antenna code, it can be picked from the dropdown at the bottom of this tab and Use this antenna clicked to insert the selected antenna. Then setting the values would be completed normally as noted above.

Periodically, NGS updates their list of antennas and a new list is made available. This is the purpose of the Update Ant_info.003 button. It will go out to the NGS FTP site and download the new antenna list.
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The Submit to OPUS button opens a new window where the selected Rinex file can be rapidly submitted to OPUS. See the OPUS section later in this document.

The Dec/Win/Splice Tab
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This tab allows for the editing of the data contents of the Rinex file. The mode changes with the selected radio button. Each of the functions stores its output file to the same directory as the selected Rinex file to be acted upon.

· Decimate 

This function thins out the Rinex data. A 1 second data rate might have been selected during field observations but 15 second data was needed. 
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· Interpolate 

Not implemented at this time.
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· Window 

This allows the user to trim the data to specific start and stop times via either an interactive slider or direct time entry. 

· Moving the Start and Stop Time sliders allows for dynamically adjusting the output.
· Direct Entry of the start/stop times is achieved via the various data/time boxes.
· Output size near the bottom of the tab is the selected interval between the start and stop time subject to the limitations of the underlying Rinex dataset. (For example, a setting of 13 seconds won’t extend 15 second data. It will be trimmed to the 15 second boundary, which would be 00).
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· Splice 
This allows the user to combine 2 Rinex files into 1.  The software does not perform error checking here for valid positional congruity or time sequence; so use with extreme caution and forethought.

The NGS B-File Tab
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Once all the data has been edited to a consistent format, this tab can be utilized.

Use of this area is predicated on several assumptions:

· A valid NGS spec SERFIL has been created for the job.
· The Rinex filenames are in NGS 8.3 format.
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Start by either entering the full location of the SERFIL file or use the … button to the right of the text box to browse to the file.
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Next, click on the Add RINEX Contents to queue.  This operation will copy the contents of the main file list box to the B-File Queue. If you have multiple folders for a job, use the File Management Tab to access the various folders, adding files as you go.
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Once the contents are in the queue, click the Create B-File non-data elements button.
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· Project Title 
If this is a NGS project, enter the approved project title as submitted in NGS Project Proposal.

· Job Code
This option has been hardwired into the software to be AA in the *aa* record.

· Organization
Enter the submitting organization.

· Abbreviation
If this is a NGS project, enter the abbreviation as created by NGS for each organization.  This should be established prior to submitting a project.

· State
Enter the 2 character designation for the state, which the majority of the points are located in. This value will be applied to all observations.

· Chief of Party
Enter the Surname and Initials of the Chief of Party for the Project.

· Second Chief of Party
If applicable, enter the Surname and Initials of the Second Chief of Party for the Project.
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· Order and Class of Survey
Select the Order and Class of Survey to be submitted.
[image: image42.png][Blue Book Header Information

Froject Tile
Orgarization

State

sobCode [

Erter 2 Character State Code

Atbreviton [

[~ Chietof Party

Sumame. Inifels
[~ Second Chif o Paty

Sumame. Inifels

Orcer and Class of Survey

Datum

[NeDE3 -NGS

Selectthe Datum to be used for processing





· Datum
Select the Datum to be used for processing.
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Next, if the survey crosses State boundaries, use the Enter/edit State Code for each station button to correct the state codes for individual stations.
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Next in line is Build Bfile Data Elements. This processes the queued Rinex files creating the required sub-elements. 
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Finally, select Build B-File. A dialog box will be brought up (default location is the folder that the SERFIL is located in) where the B-File name is entered.
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There are 2 additional buttons on this Tab, Save and Load Datasets. These give the user the option to save the B-File processing in progress if you need to exit the software before completing the B-File build.

Submit to OPUS
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Clicking on the Submit to OPUS button opens up a basic web browser with the NGS OPUS website. The purpose of this form is to easily submit files you are working on to OPUS for processing. 
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This form is partially automated in that when the form opens, the email address specified in the OPUS Tab of the Configuration is inserted. Also inserted is the antenna height of the selected Rinex file. These are static textboxes that are easily changed.

The non-automated portions are the DATA file and antenna type boxes. Since these controls are more intelligent, the contents are unable to be dynamically altered by this software at this time. To get around this limitation, the information is listed at the top of the screen for copy/paste operations. Copy the contents of the textbox into the web DATA File box and you’re on your way without having to Browse for the file. The antenna type is a little more complicated in that the antennas are options to be selected. 
Finally, the value of the Rinex file duration is listed to aid the user in selection of regular static or rapid-static submittal.

Final Thoughts and Future Plans
This software has gone through several testing phases, but there may still be errors. Please contact me via email if something comes up (it’s in the help/about screen) or you wish to extend this in some fashion.








thoman@co.gila.az.us
Also, as this software is freeware, I cannot be held responsible if you get results different than what you expected or wanted. 

At this time (Feb 2010) RM has minimal planned changes unless there is/are design extensions requested. Some future fixes are:

· Figure out how to control the OPUS web form for the data file and antenna type or have NGS implement an automated submittal form.

· Get the interpolation function working in the Dec/Win/Splice Tab. I’m not sure this will happen as I don’t like creating GPS data ‘magically.’ This would probably involve the use of the NGS interpolation software to handle the interpolation in the same fashion I’ve created a Windows interface for TEQC.
· Rewrite the underlying code. This software has been in various stages of development for the past 7 years with additional functionality added as needed. The underlying source code is rather ugly, unkempt and somewhat inefficient at this point. There are several modules that never made it beyond theoretical stage and were left in the code weeds.
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